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Each bug (that we found so far), and its work-around (when we found one; follow the () are detailed in the first section.

The second and third sections of this document highlight new functionalities and usability issues that are going to be addressed in the near future. These two sections are not the result of a complete usability study, but only highlight usability issues and new functionalities that pooped up while performing the testing.

Urgency of the need to correct/implement bugs/new functionalities/usability issues (same rating as reported in the document: Isolde 2 current status):

1. urgent

2. less urgent

3. to be done

4. for later

5. future research

In italic, the items that have been resolved, but still need to be tested further (and into bracket, the TAMOT version that fixes these bugs) .

Colour Codes : 

· Grey fonts – bugs / functionalities / usabilities fixed already

· Black fonts - bugs / functionalities / usabilities to be done

· Teal fonts - bugs / functionalities / usabilities not well-defined yet

Bugs

Bug: an unwanted and unintended property of a program or piece of hardware, especially one that causes it to malfunction (definition from the Online dictionary of computing, http://wombat.doc.ic.ac.uk/foldoc/)

1.1. Bugs of severity to be agreed with Shijian

1.2. Bugs of severity 1 (urgent)

1.2.1. Duplicated tasks (fixed)

· redundant (and empty) frames appear when opening a duplicated task from the navigation panel. 

· bug not repeatable on V.4.4 on 27-Jan-2000.

1.2.2. Running TAMOT from JBuilder

(a) Icon Missing : 

· the icons are missing in the toolbar when compiling and running Tamot from JBuilder

(b) serialVersionUID error : 

· can't open any Tamot files (e.g. Artista40.tmt) from the compiled version of Tamot (neither in JBuilder / cygwin)  (get the following error message : 

   
Error: java.io.InvalidClassException: javax.swing.JComponent; 

Local class not compatible: stream classdesc 

   
serialVersionUID=-3801576793736857629 local class

serialVersionUID=373524222138115598)

· The error is due to version compatibility problem when the class structure changes.

· The error disappears when the file is saved as a different file name, saved in format of the current version.

· Work-around by prompting the user to save the file as another name, when the file is opened with that error.

· In future, we should see the possibility to read old Tamot files of previous versions without the above workaround procedure when the class structure changes. 

1.2.3. Wrong Duplicate Task Detection Error

· On Artista files 4 & 40

· in Artista40, if change the default task name to a unique name OR do not change the default name, and modify another attribute for that task, the system believes this task is a duplicate )c/f. get same message as for duplicates)

( 1. Open the Edit menu for the "Retrieve digitised..." task

2. Add the Precondition field

3. Append a space to the Name field

4. Click 'OK'

5. Open the Edit menu for the "Retrieve digitised..." task again

6. Delete the space added to the Name field

7. Click 'OK'

1.3. Bugs of severity 2 (less urgent)

1.3.1. Missing drop-down menu on bottom of screen

*2.23 (7/9/99) *

· When right click on a task that is at the bottom of the screen, the full list of the drop-down-menu item is not displayed(the end toward the end of this list disappear below the end of the screen).

1.3.2. Placement and scrolling

(a) Long task name covering the other task : 

· * (7/9/99) * 

when changing the name of a task to a long name, this can end up covering

fully another task. 

For example, if you have:



task 1

task 2

if you change the name of 'task 1' to 'an example of a very very long name':



an example of a very very long name

and 'task 2' is under that box

(b) Long task name outside window without scroll bar : 

· * (7/9/99) * 

also, when changing the name of a task to a long name (or when adding a terminal event to a task) if this task happen to be next to the border of the window, this task will be part in and part outside the window (or the terminal event won't be viewable), but no scroll bar appears.

1.3.3. Quit on new file without saving file

· If, when Quit, after having modified a file that has no name so far (ie worked from a new file), select Yes to 1st warning (the file has been modified, do you want to save it), and then select:

· Cancel within the saving dialog box, or

· Save before a file name has been entered, 

the system will exist the application without saving the file.

1.3.4. For (empty) boolean connectors

· when choosing an empty boolean connector, when you edit it, on the closing of the edition window, the following message appears: 'a task of the same name already exists'! 1st: a boolean connector is not a task, 2nd: that name should be chosen by the system, and should not presented to the end-user.

(a) Get rid of the wrong duplicate name error for boolean connectors

(b) Assign name internally and not presented to user

(c) Change boolean connector’s type as 4 radio buttons --- AND / OR / XOR / NONE

1.4. Bugs of severity 3 (to be done)

1.4.1. Html Report not viewable using Netscape

· html reports are not viewable using Netscape: the pictures appear as broken.

( Use Internet Exporer

· bug not repeatable on V.4.4 using Thomas PC on 27-Jan-2000.

· change PNG files as absolute paths and test on Shijian / Sandrine PC

1.5. Bugs of severity 4 (for later)

1.6. Bugs of severity 5 (future research)

1.7. Bugs resolved (fixed)

1.7.1. Bugs related to the file Wilcom3.tmt:

·  (2v322) on close: clear all panels

· (2v322) on close: do not ask for saving changes if no change has been done since the last changes

· (2v322) did: open Wilcom3, cut the XOR with 2 tasks linked to it, then created another task, and went into that other task to paste: paste didn't do anything, but when coming back to previous window, 1 link is lost.

· (2v322) When 'save as' under a new name, the title of the window should reflect the new file name.

· (2v322) open Wilcom3, do 1 modification, 'save as' under a new name, if you try then to quit, the system will keep asking 'Save changes made to Wilcom4?', if say yes, it will come back to your file, won't quit. Same happen if you try to open another file. And finally, when you say 'no', it quit and the new saved as file is empty! This stops me fully from working from Wilcom3.

· (2v322) when cut, the elements cut should disappear

1.7.2. Duplicated tasks

· (2v326) it's impossible to modify the attributes of a task that has a duplicate somewhere else. 

2. New functionalities 

2.1. New functionalities of severity to be agreed with Shijian

2.1.1. right click items of pull down menu on a task

· the 4 New items (task/XOR/OR/AND) when right click on a task should not exist. Instead the double click on a task should open its decomposition window, empty if that task didn't have any previous decomposition.

(a) Double click on a task : 

· If task is a composite task already : 

· open its expansion window

· else

· Make parent task as a composite task

· Open an empty expansion window as its child

(b) Add ‘Expand’ item on the right-click pull down menu

· same effect as double click on a task above

(c) Add ‘Composite’ option in task edition window

(d) Closing an empty frame : 

· Clear the empty frame from memory

· Make parent task as an elementary task (i.e. non-composite)

(e) Make a composite task non-composite in task attribute panel / task edition window : 

· Ask for confirmation to make current composite task as non-composite

· If answering yes, remove links of the parent task with all of its child expansion windows in the hierarchy

· If any of its child expansion windows are not linked anywhere, they should be deleted from memory completely. 

(f) Right click items of pull down menu with no task selected : 

· Enabled items on pull down menu : New Task / AND / OR / XOR, Paste (if cut / copy before), Edit Domain Models, Open All Frames

· Disabled items on pull down menu : Copy, Delete, Cut, Edit, Expand

(g) Right click items of pull down menu with task selected : 

· Enabled items on pull down menu : Copy, Delete, Cut, Edit, Expand

· Disabled items on pull down menu : New Task / AND / OR / XOR, Paste (if cut / copy before), Edit Domain Models, Open All Frames

(h) Keyboard shortcuts : 

· Ctrl-C = Copy

· Ctrl-V = Paste

· Ctrl-X = Cut

· Ctrl-E = Edit

· Ctrl-+ = Expand

· Del = Delete

2.2. New functionalities of severity 1 (urgent)

2.2.1. Duplicated tasks and recursion:

· Attributes of duplicated tasks: which one do we want to be/not to be duplicated? The only thing that follows is the decomposition (this is to be confirmed/think about).

· not all attributes of a task should not follow that task when copy/paste. Ex.: the associated pre/post condition, type, etc. are independent of where the task is happening. (c/f requirement doc from Nad and I where this is explained in details.)

· can't have twice the same task in the same decomposition box (when I delete one, the other one is also deleted)

· within a task A, crashes if that same task A is called again within A or within a child of A. Recursivity should be allowed, as it is important not to restrain the possibilities.

( for all these, the creation of a task with the same name, but extended with a (bis) at the end of its name, or a number, and a comment associated to it that express which task it is supposed to be exactly.

Example: "Filing it", and "Filing it (bis) or "Filing it (1)"


· some attributes of duplicated task are dependant on the context (ie where the task is called). This set of attributes is to be defined, and they should not appeared within the report generation, under the task definition, but only in context (ie where these attributes are defined). 
Ex is pre-condition: the pre-condition on a task A might be different when that task A is called within a task X or within a task Z.

Discussion about attributes: so far, the list of existing attribute is as described in the following table:

	Name
	Type
	Dependant on:

	composite
	boolean
	core

	dirty
	boolean
	context

	feedback
	text
	context

	mandatory
	boolean
	context

	maxCard
	integer
	context

	minCard
	integer
	context

	name
	text
	core

	postcondition
	text
	context

	precondition
	text
	context

	semantics 
	??
	core (Cecile/Keith)

	style
	1 of {Interactive, Automatic, Manual}
	core

	terminal
	boolean
	context

	comment
	text
	core

	decomposition
	task
	core


(a) Add new fields in task attribute panel & task edition window :

· composite, post-condition

(b) Change class structure to store one set of core fields of duplicated tasks

· Store one set of core fields for all the duplicated tasks of the same task name

· Store different instance of context fields for each duplicated task

· So, changing content of one of the core fields will reflect in all the related duplicated tasks

(c) Allow to create duplicated tasks

· Duplicated tasks = tasks with the same task name and the same core fields, but different context fields

· Core fields & context fields as defined in the above table

· If a new duplicate task is created, it will get the core fields from its set, and use default values for the context fields. This happens in the ‘Copy & Paste’ process.

· If the new duplicate task created is renamed afterwards (like from ‘save’ to ‘save as’), it will get another instance of the core fields, besides its original context fields. So its core fields can be changed without affecting the core fields of its original task, which it originates from.

(d) Allow to have different duplicated tasks in the same window

· Delete one of the duplicated tasks should not delete the others.

(e) Allow to have recursive duplicated tasks

· Task A can have another task A as its child in the hierarchy.

(f) Report generation to report duplicated tasks properly

2.2.2. Reporting facility (not well defined yet)

* (9/9/99) * 

This is a vital element if we want to be able to use TAMOT in projects. We should also be able to print it (at least).

As a guideline, the report should have the following structure:

page 1: table of content (with page numbers of the different tasks)

and then, for each task:

- its name (as a heading)

- if not an elementary task: its decomposition

- the associated comments 

the reporting facility should be extended to a minimum of:

Example of table of Content for Wilcom-10.tmt.html, where each item is a link to the bookmark for that particular task:

Table of content:

Root


Create


Filing


Edit & File

Filing (in Parent's name-s-)


Storing it


Finding it


Reserve it


Discard it


Check it out


Cataloging it


Generate a list/catalogue


Archiving

Edit & File (in Parent's name-s-)


Filing


Edit


Filing (bis)

Storing it (in Parent's name-s-)


Check it in


Check it in as a new original

Check it out (in Parent's name-s-)


Copy it


Record details


give it


Audit

Check it in (in Parent's name-s-)


Cataloging it


File it


Archive copy


Discard copy

Audit

Check it in as a new original (in Parent's name-s-)


Label it as a new original


Storing it (bis)

File it (in Parent's name-s-)


Store card


Store it

2.2.3. right click items of pull down menu on a task & Comments (need to think about)

· the Edit item when right click on a task should not exist, and the edition of all attributes should be done via the 'Task attribute' panel (this panel should be renamed), and this should integrate the various comment fields: synonyms, tips, warning, definition, description, general comments. 

2.3. New functionalities of severity 2 (less urgent)

2.3.1. Ability to enter comments on high-level tasks

· When no task is selected, should be able to enter comments for the high level task in the comment panel. At the moment, can't enter a comment on the high level parent task. The same also applies at all other levels.
( create a dummy high level task (for the high level) and enter comments from the parent's window, when the task is selected.

2.3.2. Multiple task selection

· Multiple task selection with Shift key: needed if we want to be able to use it as a working tool. To be able to cut and copy somewhere else, at least.
( to cut/paste tasks 1 by 1 and re-create the structure between them

(a) Ability to copy 1 task

(b) Ability to cut, paste & copy multiple tasks

(c) Ability to select multiple tasks with Shift key

2.3.3. Search

· should also search on part of a name (ie if 'bla' is entered, should search on: *bla*)

· the find should make available the possibility to find next iteration of a task. 

(a) Search on part of a name

(b) Find next facility

2.3.4. Option to add comments in html report generation

· add the possibility to generate the html or not for the comments

2.4. New functionalities of severity 3 (to be done)

2.4.1. Use TAMOT for new spec (not well-defined yet)

· In light of the new development, to work on the TAMOT2 requirement specification to make it explicit, especially for the domain modeling.

2.4.2. Comments (not well-defined yet)

· Add template for task comments with the following format:

· heading1

· heading2

 … …

· heading 6
2.4.3. Enter task name before creating a new task

· Prompt user to enter task name before create a new task, or, make the new task name selected and editable in the task attribute panel.

2.4.4. Task deletion by pressing the ‘Delete’ key

· Task deletion should be available on pressing the delete key.

2.4.5. task name

· When changing the name of a task to a long name, another task may be fully obscured

· When changing a task name such that it stretches beyond the boarder of the window, scrolling bar should appear.  

· Repeat in 1.3.2 above

2.4.6. Copy

· copy in Edition menu to be added

· Repeat in 2.3.2 above

2.4.7. Option of what to view in “Task Attribute” panel

· the user should be able to decide what they want to view in the 'Task attribute' panel

(a) Create a new panel to allow user what to view in ‘task attribute’ panel

(b) Display what is chosen in ‘task attribute’ panel

2.5. New functionalities of severity 4 (for later)

· All buttons need to have contextual help

(a) Contextual help for all buttons

· It should let the user to decide whether to display links in the hierarchy window.

(b) Option to display links in hierarchy window or not

· Colour coding: users can set collars to tasks.

(c) Configurable colours for selected tasks & unselected tasks

· Create a backup when save an existing file

(d) Create a backup when saving an existing file

2.6. New functionalities of severity 5 (future research)

2.7. New functionalities resolved

2.7.1. Close

· (2v322) A “Close” option should be added to the File menu

2.7.2. Saving

· (2v322) When saving an existing file, the system should not promote for new file names, instead it should just save the content to the existing file.

· (2v322) When save a new file or save as, it should warn users if existing file name is entered

· (2v322) The system should promote the user to save changes, before:

· starting a new file

· opening another file

· closing the working file

· quitting the application

· (2v322) When save as:

i. prompt to the same folder as that of the current working file

ii. select the current file name at default

3. Usability issues

3.1. Usability issues of severity to be agreed with Shijian

3.2. Usability issues of severity 1 (urgent)

3.2.1. Modify titles of comment panel & task attribute panel

· title of the comment panel should be: "Comments about <task name>", and of the attribute panel: "Attributes of <task name>"

3.2.2. Ability to open a folder in open file dialog box

· open file dialog box: the Open should also open the folder. At the moment, if a folder is selected, and open, just quit the dialog box with no action.

3.2.3. To ask confirmation when deleting a task

· ask confirmation when deleting

3.2.4. Change cursor to hour-glass when system busy & restore cursor to normal when system not busy

· when the system is busy (for example, when creating the html), there should be a feedback to the user that nothing can be done until the system has finished, for example the cursor could change shape (cf a clock).

3.2.5. Combo box for task’s style (Automatic / Interactive / Manual)

· In the edition window and Attribute panel, task's style Automatic/Interactive/Manual should be selected from a drop down menu, the words should not have to be typed in.

3.2.6. Repositioning of ‘Dirty’ field in task attribute menu

· the Dirty attribute should appear in the same position in both the attribute panel and the edition window (might disappear once we get rid of the Edit window, c/f new functionality of severity 1: 'right click items of pull down menu on a task & Comments')

3.2.7. Showing the link when a link is being created

· when creating links between task, some feedback need to be provided (tracing where the link is coming from, and following the pointer).  

3.2.8. Boolean connector's edition window

· boolean connector's type OR/AND/XOR should be selected from a drop down menu, the words should not have to be typed in (as they are in the Edition window).

· the internal name of a boolean connector should not be displayed to the end-user.

· Repeat in 1.3.4

3.3. Usability issues of severity 2 (less urgent)

· On the right click menu, non activated items should be greyed

· Repeat in 2.1.1

3.3.1. Frame to display tasks of the same name

· when the message appears about the duplicated tasks, a way to open all frames containing that particular task should be provided (same as the search facility)

3.4. Usability issues of severity 3 (to be done)

· Save: file format to be more explicit (right now, don't know what is what, and what they are/do/don't

(a) File format on save

· In 'task attribute' panel, all field should be able to be modified

(b) Making all fields modifiable on task attribute panel

· when open an existing file: should re-open with the same configuration than when it was closed (same window open, and same size and placement of windows)

(c) Remembering states of file save; Restoring states of file when it is opened

· grey in menu options that are: not valid in the current context, not implemented

(d) Grey menu options that are not implemented

(e) Grey menu options that are not not valid in current context

3.5. Usability issues of severity 4 (for later)

3.6. Usability issues of severity 5 (future research) (not well-defined yet)

· It is difficult to understand the presentation and the organisation of information. It would be preferable to have a reflection about how to present Diane+ to non-expert users in a way that simplify the use of Diane+. The issue would be to explicit the relation between the rules of Diane+ notation and the interface presentation for the users.

· It is very difficult to work on large task models. It would be interesting to conduct research in the field of studies dealing with “complex data visualisation or representation” ( ie, tree metaphor, space metaphor, etc) to test new interfaces.

· A lot of icons and terms seem not explicit or too specialised in the toolbar or in the top of the window. It would be useful to test different set of terminology and icons with technical writers. It can be started by build a map of terminology and icons.

3.7. Usability issues resolved

3.7.1. Task attributes

· *13/9/99*
View, on the TM, of the feedback and terminal event

· * (7/9/99) *  Manual task SHOULD be re-introduced (in addition to Automatic and Interactive). 

3.7.2. Close/Quit and Save

* (9/9/99) * 

Saving/quiting

when quiting TAMOT, if there has been some modifications that have not been saved, the user should be prompted (this is standard over any software application).  
4. Released versions of TAMOT and details of fixes

can be found in Religion:\I2Tech\F:\Projects\Isolde\Tamot2\

4.1. TAMOT2 version 4.4 (Tue, 18 Jan 2000 18:22:09)

It include the following improvement comparing to version 4.3:

* replace space with dash for semantics when exporting to LISP

* when a task name changes, connected links no longer keep old task name

when exporting to LISP

* Language server can be changed on the fly

4.2. TAMOT2 version 4.5 (Mon, 24 Jan 2000 16:04:22)

It include the following improvement comparing to version 4.4:

* Display Language generation status from the LISP server

* Get rid of "generation from <file name> popup

* Change all "Edition" labels to "Edit".

4.3. TAMOT2 version 4.6 (Tue, 25 Jan 2000 15:45:02)

It include the following improvement comparing to version 4.5:

* Multiple instances of tasks with the same name are dumped as different

diane-actions sharing the same semantics when exporting to the language

generation engine.

Isolde testing report, by Sandrine

12

